4b. MS Excel — grafy, razeni dat, filtry
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Trocha teorie k vizualizaci dat

vizualizace dat = interdisciplinarni obor, zabyvajici se grafickym
zobrazenim dat a informaci

hlavni cile — lepsi srozumitelnost a prehlednost slozitych nebo
velkych datovych sad

AI: Graf neni jen obrdzek, je to myslenkova struktura, ktera
prekilenuje propast mezi chaotickym svetem surovych dat a
usporadanym svetem lidského chapani a vhleadu.

nas mozek zpracovava vizualni informace mnohem rychleji a
intuitivnéji nez abstraktni tabulky




Vyznam pouziti grafu

zjednoduseni slozitych informaci

nazornost (nutna vhodna volba typu) — kazda vizualizace je
interpretace dat (graf vychazi vzdy z tabulky hodnot)
umoznuje videt v samotnych cislech:

— trendy

— Vvzorce

— korelace

— anomalie, ...

efektivni komunikace — prezentace a rozbory, predani klicovych
informaci

podpora rozhodovani (kvalifikovanéjsi rozhodnuti, podpora
strategie)
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Systémy pro tvorbu grafti

tabulkové procesory (MS Excel, Google Sheets, ...)

— snadné pouziti, dostupnost, nabidka riznych typt grafti, pouziti grafu i v
ostatnich aplikacich baliku nastroj (Wodr, Powerpoint)

— X omezené prizplsobeni vzhledu, neinteraktivni, nevhodné pro velka data
— studenti, kancelarské vyuziti
online nastroje (Canva, Datawrapper, RAWGraphs.io, Draw.io)
— moderni design, bez instalace, snadné sdileni na web, drag&drop
— X placené pokrocilé funkce, méneé flexibility pfi praci s komplexnimi daty
Specializované vizualizacni nastroje
— analyza a vizualizaci velkého objemu dat (miliony radkd dat), interaktivita
— x drahé, treba hlubsi znalosti
— datovi analytici, manazefi, korporace
Programovaci jazyky a knihovny (Python, JavaScript, ...)
— na miru, neomezena kontrola nad kazdym detailem, integrace do webu
— X potrebna znalost programovani, Casové narocnéjsi nez graf naklikat
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Co je treba si uvedomit pri tvorbé grafu

Ceho chci vizualizaci dosdhnou?
Pro koho je vizualizace urcena?
Volba spravneho typu grafu:
— sloupcovy — porovnani hodnot mezi kategoriemi (diskrétnimi)
— spojnicovy — zobrazeni vyvoje v case
— kolacovy — znazornéni podilu ¢asti na celku (100%)
— bodovy — zobrazeni vztahu mezi dvéma proménnymi

maximalné jednoduse a prehlednée (odstranit vSe, co neni
podstatné)
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Chyby pri tvorbé grafu

zamerneé X nechténé

vizualni design
— prilis mnoho barev, car, znacek, neprehledné 3D efekty, stiny
— Spatné odliSitelné barvy
— pouziti nevhodného typu grafu
skala
— o0sa Y nezacina v 0, v ramci 1 grafu a jedné osy X jsou zobrazené rlizné
nesouvisejici datové rady

kontext
— bez vysvétlivek, bez kontextu, bez legendy — Spatné pochopitelny
— vyjadruje zaver, ktery data neprokazuiji
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Priklady...
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Jednotliv

V 4

S

casti grafu

zdrojova
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Vytvoreni grafu

b° s

e VloZzeni» typ grafu

e moznost upravovat pozdéji
jednotlivé Casti grafu
samostatné
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Spojnicovy

Nazev grafu

pioili} nm 2002 1003 04 2005 2006 2007 2008

Spojnicovy graf se pouZiva k zobrazeni trendd v éase (roky, mésice a dny)
nebo kategorii, u kterjch zaleZi na pofadi. PouZijte ho, pokud mate
hodné datowych bodd a poradi je ddlezité.

Zrudit

EUR
mUSD
GBP
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Typy grafli

sloupcovy
pruhovy
spojnicovy
vysecovy
XY bodovy
plosny

prstencovy
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paprskovy
povrchovy
bublinovy
burzovni
valcovy
kuzelovy

jehlanovy
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Sloupcovy graf (Bar/Column Chart)

e porovnavani hodnot mezi diskrétnimi kategoriemi
o délka sloupce Umérna hodnoté nebo Cetnosti, kterou reprezentuje
e 0sa X — kategorie, osa Y Ciselna hodnota
e zacatek osy Y vzdy na nule (x chybna interpretace)
e varianty — skupinovy, skladany, 100% skladany, pruhovy (rot. o 90°)
e kdy ne: Casoveé rady, rozdéleni Cetnosti (histogram)
. gstdéré EDSE EEIE% EDEE EEIIE EEI:I% 2EIEI§ EEIEI? EEIEE EDSE 5

cervene 10 13 g 10 20 30 23 10 10



Spojnicovy graf (Line Chart)

zobrazeni vyvoje, trendl a zmén hodnot v ¢ase nebo podél
sekvencni osy (linie vizualné zdlraznuje plynuly prechod a trend)

vizualizace Casovych rad nebo sekvencnich dat (prirozené
usporadanych do posloupnosti)
osa X — cas (konzistentni usporadani), osa Y Ciselna hodnota
priklady pouziti:

— data meérena v pravidel. intervalech (kurz akcii, teplota, navstévnost)

— porovnani trendd u vice datovych fad (napf. rlst prodeje dvou
konkurencnich produkt()

varianta — plosny (zdlraznéni celkového objemu)

kdy ne. prO nesekvenéni data Vyvoj kurzu eura a amerického dolaru

26,00
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(XY) bodovy graf (Scatter Plot)

zobrazuje vztah mezi dvéma hodnotami (X a Y), vynasi jednotlivé
datové body do souradnicového systému X a Y

— kazdy bod = 1 pozorovana jednotka, ktera ma hodnotu pro X i Y osu
(napr. Clovek — vaha/vyska, stat — Iékarska péce/délka zivota) =>
zjisténi, zda existuje vztah mezi vyskou a hmotnosti

identifikace shlukt datovych bodUl (cluster(l) a odlehlych hodnot
osa X (horizontalni) nezavisla proménna (napr. vynalozené usili,
reklama, pricina) - osa Y (vertikalni) zavisla proménna (napr.
vysledek, trzby, efekt)

11l Bodovy graf nam ukaze, ze dveé véeci se pohybuji spolecné
(koreluji), ale nikdy neprokaze, ze jedna véc druhou zplsobuje
(kauzalita), mQze existovat treti, skrytd proménna.

varianta — bublinovy graf (3. proménna: velikost bubliny/bodu)

kdy ne: Casové rady, porovnani kategorii
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Bodovy / bublinovy graf - priklady

e https://youtu.be/Z8t4k00Q8e8Y?si=z0s32anenvjSkFJT
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https://youtu.be/Z8t4k0Q8e8Y?si=zQs32gnenvjSkFJT
https://youtu.be/Z8t4k0Q8e8Y?si=zQs32gnenvjSkFJT

Vysecovy/kolacovy graf (Pie Chart)

\E & 4

e vizualizace rozdéleni celku na dilci casti
e zobrazeni proporcionalniho podilu jednotlivych Casti na celku (soucet
vsech Casti musi byt 100 %).
e ne vice nez 5-6 kategorii
— Spatné se rozeznavaji velikosti Ghl{
— > kategorii — lepsi sloupcovy nebo pruhovy graf serazeny podle velikosti

e zobrazeni rozd€leni trhu, procentualni slozeni populace podle veku,
volebni odhad

e varianty — rozdéleny, prstencovy

Odhady voleb duben 2009 4,40% 35,10%

¢ssb
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mSZz

KDU-CSL

m Ostatni

5,60%

B KDU-CSL; 4,40%; 4%

B 57;5,60%; 6% .
B ¢SSD
B 0oDS

B KSCM 10,50%

msz
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Paprskovy graf (Radar Chart)

porovnani vice subjektd (napr. produktl, tymd, jednotlivet) podle
vice kritérii nebo metrik

porovnani probiha vzhledem k hodnot€, ktera se zobrazuje ve
stredu mezi hodnotami

paprskove osy rovhomerné rozmisténé kolem stredu (minima) —
kazda osa (paprsek) predstavuje jednu proménnou nebo kritérium
(napr. rychlost, cena, kvalita)

vSechny proménné musi mit stejné méritko nebo musi byt predem
normalizovany do stejného rozsahu (napr. 0-100%)

Assist

hodnoti se tvar polygonu :
— vetsi plocha nebo vycnélky ¢
v urcitych smérech = siln€jsi vykon RS

v dané oblasti

20 Block shot

Free throw Field goal 1 7
2 i v




e pf. —obsah vitaminG v rlznych jidlech

vitamin A

vitamin E
Gymnast Scoring Radar Chart
¥ Gymnast 1 * A
B Gymnast 2 xecution
Gymnast 3 == B
* C
nding

vitamin C
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Vytvoreni grafu

2000
2001
2002
2003
2004
2005
2006
2007
2008
2009
20310
201
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35073
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29299
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Nastroje grafu — navrh grafu 1

VloZeni RozloZen( stranky Vzorce Data Revize Zobrazeni Mapovéda Mavrh grafu Format
TP —— — - \]7) gq |:|:|] E‘:‘
@ rAvavd | S =" [T AVIYAREETA® Voo AN s 2N == E@ il il
Piidat prvek  Rychlé Imenit | 1D e e T TS T : 75T —| | Prohodit fadek Vybrat | Zménit | Presunout
rozloZeni~ | barvy ~ a sloupec data typ grafu graf
Styly grafd Data Typ Umisténi
rrodré Zluté Zervend 40
7 v 7 2000 20 ] 10
nastaveni casti grafu m_ B 5630
2002 15 30 8
2003 10 18 10
A A 4 )4 f 2004 B 10 20 20 S 4
MOZNa Zzmena pU gra u 2005 B 4 30 10 Y e
2006 10 1 25
’ )4 2007 17 a 10 0
vyber dat L - U
modre Zlute cervene

zameéna reprezentace sloupct a radkd ”

30
2000 2001 2002 2003 2004 2005 2006 2007 2008 20 —
modré 20 18 15 10 B g 10 17 25 10

Zluté &) 3 30 15 10 4 1 &) 2 0

cerveng 10 13 8 10 20 30 28 10 10 O N A D &
O " O N’ O
A S

prednastaveneé styly, rozlozeni + moznost individualniho nastaveni
presunuti grafu

— na pozici v ramci listu

— jako novy list
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Umisteni grafu

Presunout graf ? ot
T Fe Zvolte poZadované umisténi grafu:
B C | D | E | F | G | H | | J | K | L
LH_J,"J () Mowj list: | Graf1
2000 2001 2002 2003 2004 2005 2006 2007 2008
maodré 20 18 15 10 6 g 10 17 25 |._|J_J.‘ ® Opjektw RIS w
Zluté 5 20 30 15 10 4 1 5 2
Eemveng 10 13 8 10 20 30 23 10 10
Vyvoj poctu prodanych kus
35
30
25
20
- £
15 12 o )
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10 i 7
v
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0 0
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—OOTE  — e s— Eryensd 5
20
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15
5
sioupcovy | spojnicovya XV | paprskawy | wysecow | mix | Listt @® [T

Graf2 | Graft




Nastroje grafu — navrh grafu 2

moznost nastaveni casti grafu

— nazev grafu
— 0osy

— mrizka

— legenda

— popisky dat

— tabulka dat

funkce pro analyzy grafu

— spojnice trendu
— chybové usecky
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15
10

5
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modré
m7luté
m Cervené

20

10
i
2000
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Prodejnost zbozi
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6 J
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Nastroje grafu - format

Soubor Domi WloZenl RozloZeni stranky
Rada "modré" \ \

djﬂ Formatovat wijbér Ooal-

] Obnovit podie stylu ATLLF

Aktudini wibér VloZit obrazce

o format j

Vzorce Data Revize Zobrazenfl Napovéda Navrh grafu Format
ﬂ Vyplfi obrazce ¥
BEHEHEE iz A
| @ Efekty obrazce
Styly obrazcd e}

ednotlivych Casti grafu i

datovych rad
— cCastecné zavisi na typu grafu
e sloupcovy

— prekryv sloupct
— mezery mezi sloupci

e spojnicovy

— velikost, tvar a barva znacky
— zobrazeni vynasecich car

— obrys, vypln, efekty

o velikosti
e usporad

14 7

ani, ...

Styly WordArt

[+]

=

Alternativni
text

Format datové rady

Moinosti fady
H Ol

~ Cara Inatka
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Beg céry
PInd éara
Pfechodova cara
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Barva
Prihlednost ———— 0%
§|’Fga
Typ sloZené Céry
Typ pierufované Cary
Typ zakoncenf Eéry Kulaté
Typ spajeni Oblé

Typ ipky na za&atku
Velikost Sipky na zacatku
Typ Sipky na konci

Velikost Sipky na konci

["] Hiadka &4ra

Pfistupnost

- B
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=
—
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Podokno Zarownat
vybéru
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Velikost [F]

Format datové rady v
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Rady
h\_:\‘ ® Hlavni osa
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Piekntifad ———+H—— 0%

Sitka mezery ———————— | 150%

Velikost

x
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Dalsi upravy datovych rad
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Format osy

e Format» Formatovat vyber
e u grafll pouzivat popisy os

[vCetné jednotek]

o format Cisla
e rlzné pro vodorovnou a svislou osu
e dalSi mozna nastaveni

zavisi na typu grafu
minimum a maximum
velikosti jednotek

e po kolika hodnotach se uvadi
znacky

protnuti os
logaritmické méritko

[+]

=]

Format osy M E

Moznosti osy ~  Moznosti textu
o9 =Ml

~ MoZnosti osy

Meze
Mipimum 0.0 Automaticky
Maxirnurm 35,0 Butomaticky
Jednatky
Hlavni 5.0 Automaticky
Vedlejsi 1.0 Automaticky

Vodorovna osa protina

* Autormaticky
Heodnota na oze

Maximalni hodnota na ose

Zobrazené jednotky Zadné -

] Logaritmické
méfitko

] Hodnoty v obraceném pofadi
> Inacky
> Popisky

v Cislo

Kategorie

Cislo - |

Desetinna mista: 2
Oddélovat 1000 (mezera)
Zéparna cisla:
-1234,00
123400
-1234,00
-1234,00
Kéd formatu @
£ ££0,00 Pfidat

] Eropaojeno se zdrojem

k
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vodorovna osa

e svisla osa

[+]

Format osy

MoZnosti osy ~  MozZnosti textu
P =
O Q@ oM

~ Moznosti osy
Typ osy
® Automaticky vybrat podle dat
) Osa textu
Oza data
Svisld osa proting
. Autormaticky
) V kategorii éislo
)V maximalni kategorii
Pozice osy
) Na znackdach
Cl Mezi znackami

[| Kategorie v obriceném pofadi

Format osy

Moznosti osy ~  MozZnosti textu
s —
O O o= ol

~ Moinosti osy

Meze
Minimum 0.0
Maxirmum 35,0
lednotky
Hlawni 50
Vedlegsi 1,0

Vodorovna osa proting

. Autornaticky
) Hodnota na ose

' Maximalni hodnota na ose

Zobrazené jednotky

[ Logaritrické
méritko

[] Hodnoty v obraceném pofadi

- KE

2

Automaticky

Autormaticky

Automaticky

Automaticky

Zadné -

26



€L0°GE
bwL'LL
€L'oz

2D grafy —
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Zmeéna dat, popis os

e moznost Upravy dat

— Navrh grafu » Vybrat data
popis grafu z tabulky

Vyhbrat zdroj dat

ot
Oblast dat grafu: | =sloupcovy!SB53:5K56] +
& Prohodit fadek a sloupec
PoloZky legendy (fady) Popisky vodorovné osy (kategorie)
i pfidat | 77 Upravit | < Odebrat FZ Upravit
modré 2000 A
Futé 2001
fervené 2002
2003
2004 "
Skryté a prazdné buriky Zrusit
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Graf funkce

e vytvoreni grafu funkce (x*2, 1/x, ...)
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3D grafy

e nastaveni jako u 2D grafu

+ format oblasti grafu » moznosti grafu » efekty

X [

Format oblasti grafu M

Moinosti grafu ~  MozZnosti textu
—
O Qe

> Stin

» lare

> Mékké okraje

> Prostorovy efekt

v Prostorové otofeni

Predvolby

Otodeni podleosy X 407
Otoceni podle osy ¥ 157

Otocenl podle osy £

Perspektiva 15° - |:

Vzdalenost od spodni Easti

[[] Bez perspektivy

Automatické méfitko

Hioubka (% zakladny) 100

Viska (56 zdkladny)

w

Prodejnost zbozi

Pocet prodanych kusti
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3D grafy
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Netradicni grafy

i | B 5 12 Pruhovy graf s popisem ST—
M - I I o 11 1 =1
12 | . - 10 2 -
1 [ .
2 [ I - 9 3
I
g 1 K 8 4
1c [ I --
- I 7 ¢ 5
Hl E

Plosny graf se spojnicovym

Tachometr

&
3
12 + 380° =, 30°
7 N2 £ \
10 { N\~ )
300 1% y 60°
8 40% 0%  gog XX
30% 70% T T RIS TN
6 + — — 270" »" >}< 1 90
20% o 80% S——c7 T X
-, X~ X
3 10% 90% 20 / ," \ X 120
0+ T T T , 0% 100% 1’ " sor
1 3 5 7 9 11 13 15 1 e

o https://office.lasakovi.com/excel/grafy/netradicni-grafy-v-ms-excelu/

T T T T T T T T T T T
17 19 21 23 25 27 29 38
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Razeni dat

e vzestupné x sestupné

— Data » Seradit

e vice sloupctl

Petr
Alena
“adimir
Karel
“Yeronika
Petr
Petr

Petr
Fetr
“ladimir
Petr
Alena
Karel
“eronika

Flegaty
Siroka
Krotky
“esely
Ylasata
Krotky
Dlouhy

Olouhy
Krothky
Krotky
Flegaty
Sirok4
“esely
Vlasatéd

' Petr
Petr

Data Revize

[T Dotazy a piipojent

Zobrazeni

Mapovéda

B m g I

Organizace.. Akcie (Ang.. Mény (Ang.. Zemépis (.. |=

%l Sefadit

2R N

Filtr
% Upfesnit

izy a pfipojeni Datové typy Sefadit a filtrovat
. Petr Alena Viadimir
é Alena Karel Veronika
Alena Sirokd Vladimir Petr Petr
Karel Yesely Karel
. => Petr Petr
Plesaty Veronika Pat Pat
Kratky etr elr
Petr Dlouhy Petr Veronika Karel
Yaronika Vlasata Petr Viadimir Alena
Wladimir | Krotky
Sefadit ? x

— Piidat Grovef

< Odstranit droveri

E@ Kopirovat droven

“w || MoZnosti...

Data obsahuji zahlavi

Slaupec Razeni Poradi

Sefadit podie Hodnoty bunék v| |aaiz v

Potom padle | jméng e Hodnoty bunék w| |AazZ ~
Zrusit
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Filtry

vybér polozek ze seznamu podle kritéria jméno e

Data » Filtr (zapnout/vypnout) ot kit
-, i , , Karel _ ‘v’eselg?'

tvori se pro celou tabulku v 1. radku (zahlavi) TR

Petr Dlouhy

pro vsechny sloupce .
- S bard , T NN mere  piimer
— filtr pouze pro nektere (sousedni) Petr__ Dl

jméno  |pfijmeni Alena Siraka

/he . [ =] Plagati Yladimir  Krotky

sloupce — vyber (oznaceni) sloupce R I e
ladirir  |Krotky “eranika Vlasa!é

Karel esal] Fatr Krotky

“eronika [Vlasatd Petr Dlouhy

Petr Krotky

— polozky ve filtru — vSechny hodnoty v daném e o
sloupci (kromé hodnoty zahlavi)

iméno [=|pifmel~]
Pal Sefadit vzestupné
Al Sefadit sestupné

i
A (Prvnich 10..)
(lastni )
e Dlouhy
Py Krotks
Pet Plezaty
Siroka

esely
Vasatd
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Vlastni filtr

napr. vybér vsech polozek
zacinajicich urcitym pismenem

— polozka Filtry textu v daném
filtru

-

Vlastni automaticky filtr

2 -] |

Zobrazit Fadky:

Znak ? zastupuje jeden znak.
Znak * zastupuje posloupnost znakid,

prijmeni

=] [v =]
MpE =]

Ma na zactatku
D) A @ Nebo

Ma na zatatku

artovn = | pfijmeni |7 jméno |~ If_'-’l"u’l
21 Vénetkova
22 Zalezly

= | datum narozd * | vék
5.6.1980 32
6.11.1983 29

Vaclava £
fdenék M

Sefadit od Ado 2
Sefadit od 7 do &
sefadit podle barvy

Filtry textu

[ (Wybrat vie)
w9

] 13

[ Autorsky
-] Bubdkova
o] celkem
[ Cipisek
-] Dudak
[ Elfovd
[+ Fialava
-] Gumov
-] Houska
o] Tlich

] Jelinkaovd
[ Kropadek

| I P S

Rovna se..
- Merovna se...
Ma na zacatku...

Ma na kondi...

m

Obsahuje...

Meobsahuje...

WYiastni filtr...

| ok

] [ Storno

1
10

L]
16 18
9 b

1. poku| = | 2. poku *IS. Enku ~lsouget [+ kvalifikd ~ 77+ pofadi

35 AND i 2
24 NE 14.
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Zpracovani rozsahl

ejsic

4

h dat

e rozsahlejsi soubor dat (napr. body ze cviceni)

} €. kr. Prijmeni | Jméno | 0s. éisle P1* p2' P3* Py p5* P6' P7’ Pg' E Test
| net  |AMDERT |Lubos A0s029 30 40 8,0 .0 6,0 6,0 70 4.0 + 40
i koh  |AUGUSTAMartin A0s0E2 40 40 8.0 G0 6.0 6.0 a0 8.0 + 500
i net BABCWAH ana AD5263 20 4.0 8.0 a0 40 G0 a0 a0 + 420
i haj BENES |Lukas AD50E5 40 4.0 5.0 a0 G0 G0 50 8,0 + 440
} kah BERAMN | Ondfe A05240 40 40 20 .0 0.0 0.0 8.0 a0 + 240
1 haj BIZZARR! [Michal AN5225 1.0 40 8.0 G0 20 3.0 a0 1.0 + 330
a net BREAMDL |Tomas ADs0E7 0.0 4.0 8.0 a0 G0 G0 a0 8,0 + 450
1 haj BROZK  |David AD50EE 30 4.0 10 0,0 G0 3.0 G0 2.0 + 250
2 net BRYCHCI|Tomas A0s039 40 40 8,0 .0 6,0 50 50 10 + 3490
3 net BRI Michal A05040 40 40 8.0 G0 5.0 6.0 a0 a0 + 450
4 kaoh CAMPR [Michal ADs042 30 4.0 8.0 a0 G0 4.0 a0 a0 + 430
= ot [ [N N =1y | R TN MNOEMNAD an An an =N mnn mnn an an = AN
\Y4 =
e Cinnosti

— TFazeni, filtrovani
— skryvani sloupct a radkd (napf. kvali tisku)

e oznaceni sloupce/radku; praveé tlacitko mysi, v menu Skryt | Zobrazit
e pozor na razeni, pokud jsou skryté sloupce (zkontrolovat, Ze se vse

seradilo spravné)
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